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1. The Munitions History Program (MHP)
 https://mhp.redstone.army.mil/MHPMAIN.ASPX provides those with access a wide variety of ammunition knowledge capabilities. 
(Appendix 1)

2. For ammunition TMs, SBs etc, users of LOGSA Logistics Information Warehouse (LIW) https://www.logsa.army.mil/index.cfm may access the Electronic Technical manuals.             (Appendix 2)

3. DAC Web-based ammunition training is available at http://dactces.org Once the site is opened select “Online Training”. A listing of ammunition classes will populate. For example, AMMO-97-DL / 4E-F64/645-F48, allows training in the Munitions History Program (MHP).              (Appendix 3)

4. DAU Ammunition Community of Practice – AMMO CoP https://acc.dau.mil/CommunityBrowser.aspx?id=220200&lang=en-US provides shared knowledge throughout the ammunition enterprise. Military personnel, DOD civilians, supporting contractors, and other agencies can leverage expertise, share experiences, ask questions and participate in discussions.
(Appendix 4)

5. Army Safety Network
https://safety.army.mil/HOME.aspx provides the Army with safety and risk management expertise to preserve readiness through the prevention of accidental loss of our Soldiers, Civilians, Families and vital resources.
(Appendix 5)

6.	Department of Defense Explosive Safety Board (DDESB)
https://www.ddesb.pentagon.mil/ provides objective advice to the Secretary of Defense and Service Secretaries on matters concerning explosives safety and to prevent hazardous conditions to life and property on and off Department of Defense installations from the explosives and environmental effects of DoD titled munitions.
(Appendix 6)

7.    Explosives Safety Engineering Division (ESED)
https://www3.dac.army.mil/det/ provides design, develop, and disseminate methods and procedures for transportation (outloading, shiploading, and containerization) of Class V items and guided missile ground support equipment in support of DOD, Army, and SMCA requirements. Formulate official AMC drawings which depict approved procedures. Prepare and recommend policies and procedures concerning transportation, containerization, and shipping operations. Recommend methods for improving depot procedures, methods, quality, safety, equipment, and facilities relative to shipping operations. Review publications pertaining to ammunition shipping for consistency with established technical, logistical, and safety doctrinal policies. Obtain approvals from MTMC, DOT, AAR, BOE, foreign governments, and other approving agencies. Provide technical assistance on outloading procedures and operations.
(Appendix 7)

8. 	COMMON REGULATION WEBSITES

DOD Issuances 
http://www.dtic.mil/whs/directives/

Army Publication Directorate (APD) 
http://www.apd.army.mil/ 

Army Material Command (AMC) Publications 
https://hqamc.aep.army.mil/Pages/Home.aspx

ASSIST Standards, Specs, Mil Handbooks, etc
https://assist.dla.mil/online/start/index.cfm

Air Force E-Publishing
http://www.e-publishing.af.mil/

Chairman, Joint Chiefs of Staff Directives Electronic Library
http://dtic.mil/cjcs_directives/cjcs/instructions.htm

9.	OTHER AMMO RELATED WEBSITES

Whole Building Design Guide – Ammunition and Explosive Strorage Magazines
https://www.wbdg.org/design/ammo_magazines.php

Naval Logistics Library (NLL)
https://nll2.ahf.nmci.navy.mil/default.cfm

Air Force Global Ammunition Control Point (GACP)
https://www.my.af.mil/ammoprod/wm/

Marine Ammunition Knowledge Enterprise (MAKE)
https://make.mceits.usmc.mil/make/ammo/login.aspx?ReturnUrl=%2fmake%2fammo%2fHome.aspx

LogiQuest Lite (WebFLIS Alternative)
http://www.webflis.us/

Defense Transportation Regulations 
http://www.ustranscom.mil/dtr/index.cfm

Electronic Code of Federal Regulations
http://www.ecfr.gov/cgi-bin/ECFR?page=browse

Ammunition Peculiar Equipment (APE)
https://prod.jmc.army.mil/apems3_catalog/index.aspx?area=resources






Appendix 1 – Munitions History Program (MHP)
Munitions History Program (MHP) https://mhp.redstone.army.mil/MHPMAIN.ASPX
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Appendix 2 – LOGSA Electronic Technical Manuals (ETMs)
Website LOGSA: https://www.logsa.army.mil/index.cfm
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[image: ]Electronic Technical Manuals (ETMs)


[image: ]If you don’t have access to ETM app apply here.
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[image: ]Example: Enter “Data Sheets”
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Appendix 3 – DAC Ammunition Training “On-Line”
http://dactces.org
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Appendix 4 – DAU AMMO CoP
https://acc.dau.mil/CommunityBrowser.aspx?id=220200&lang=en-US
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Appendix 4 – The Army Safety Network
https://safety.army.mil/HOME.aspx

[image: ]Range and Weapons Safety Toolbox
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Appendix 6 - Department of Defense Explosive Safety Board (DDESB)
https://www.ddesb.pentagon.mil/
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Appendix 7 - Explosives Safety Engineering Division (ESED)
https://www3.dac.army.mil/det/
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Al new MHP users must submit 3 registration request. To do thi, log in at
bitos://mhocedstone.arme.l,

‘A CAC, ECA, or PKI certficate is required to access the
website. Tip: Users must select their email cerificate, and select OK ater login.

‘Complete the request as described below. A meszage appears to notiy you that your
Registration is successful. lease allow 24-45 hours for the JMC Administrator to process the
Registration request. Users wil receive an emal notification when thei request is
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By completing the fields in red in the Information section, users receive automatic access to
the following modules and access levels: Maifunctions DA4379 and DA4379-1, Ammo Help
‘Ack a Question, and Help Desk. Select *T need additional MHP Access" at the battom of the
page t submit a request for additional modules.
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1F you dick "I Need Additional MHP Access” on the Registration form, you can Request
Profile Access or request access to addifional modules in the Request Access section.

To request a Profile, select the Profile from the drop-down menu and click "Add". NOT!
In order to select a Profile in Request Profile Access, your account must indicate that you
are a US Citizen. Some of the common profiles are-

'SOLDIER Profile- includes access to JHCS, Suspensions and Restrictions/AINs, ASIS,
Ammunition Data Cards, Ammunition Condtion Reports, WPM Report, and AME modules.

DA EMPLOYEE Profile- includes access to JHCS, Suspensions and Restrictions/AINs,
ASIS, Ammunition Data Cards, WPM Report, and AME modules.

OTHER SERVICE Profile- includes access to JHCS, Suspensions and
Restrictions/AINs, ASIS, Ammunition Data Cards, and AME modules.

IF the applicable Profile that you select does not meet all of your access needs, you can also
select individual Modules. In the Request Access section, select a Module from the drop-
‘down menu for which you want access. If the Module does not appear, look in Current
Access to ensure that you do not currently have access to it. Select the Access Level from
the drop-down menu that you want. Click "Add" to add the Module and Access Level to your
request, which appears in "Requested Access To”.

Certain Profiles and modules require that you enter 3 DODAR/UIC. If requested, enter your
DODAAC/UIC in the textbox, or dlick #to search for it. When the DODAAC/UIC List appears,
you may enter the DODAAC/UIC or Description and click Search, or scroll down and select
the DODAAC/UIC. To exit the DODAAC/UIC List, dlick "Clear” or the *X". Click "Add".

In Verification/ Additional Information, enter the reason why you are registering for
MHP access. This field s required in order £ submit your request. Contractors need to
include Contract Operations Representative (COR) contact information. Your Government
Entity must send an e-mail to that provides justification and
verification for the requested modules or your request wil be rejected.

Scroll to the bottom of the page and diick "Submit” to send the Request for Access to MHP.

A message will appear notifying you that your Registration is successful. Please allow 24-48
hours for the JMC Administrator to process your Registration request. You will receive an
‘email notification when your request is processed

Acceptable Use Policy (AUP). The AUP must be signed uploaded in order to submit
your registration.

To Download and Sign AUP, select the MHP Acceptable Use Policy link. Scroll down to the
bottom of the document, and dick the signature field. Select the email certificate from the
Sign As drop-down menu. Press the Sign button. Select File > Save as on the menu bar of
Intemet Explorer. Press the Save button. The file should save to your computer’s
Documents folder containing digital signature. Close the document.

To Upload the AUP, assure all fields in red are complete in the User Information section.
‘Select the Browse button. The "Choose File to Upload" window opens. Select the AUP For
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Fill & Sign

Comment
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MHP.pdf file, and press the Open button. The path to the file populates in the Acceptable
Use Policy textbox; for example, C:\Users\kristin.terry\Documents\AUP For MHP.pdf.

To View your signed AUP, o to Help>User Information/Request Access after the
registration request is submitted and approved; select the Signed AUP link at the top of the
page, and open.

To request additional access after your account is approved, dlick on "User Information/
Request Access” under the Help tab. Then dlick on the "Request Access” tab. Scroll down to
the Requested MHP Access section of the page and click "New”. Select the module you
‘would like to request in the Module drop-down menu. Select the access level you would like
to request in the Level drop-down menu. Enter a Justification for the access request and
dlick "Add". To request additional Profile Access, scroll down to the Requested Profile section
ofthe page. and click New. Select the profile you would like fo request in the Profile drop-down
‘mem. Eater a Justfication for the access request. Click Add. Requests are nommally processed
within 24-48 hours. You will receive an email when yous request is processed.

To change your Access Level for a Module that you already have Access, such as the
WARP (ADC) Module, go to ‘and dick "Request
‘Additional Access". For ASRP, send an email request to

Contact the MHP Help Desk, 3
DSN 597-2143, commercial 256-313-2143, or submit a help ficket at forany
questions.

Account Expiration. Your MHP access automatically expires if you do not log in at least
‘every 35 days. If you would like to request to have your account access reinstated, enter
the reason you need MHP access in the textbox. Click Submit. Reinstatement typically takes

2448 hours to process. You receive an email notification when your account is reactivated.

Munitions History Program (MHP) distance learning training is available through
ALMS. Register through ATRRS using course number 4E-F64/645-F43 (formerly AMMO-97-
DL). The course provides extensive information to successfully navigate within the MHP
website, retrieve Depot Surveillance Records (DSR), and create new inspection records and
data record headers. Students will become familiar with main menu modules, submenus,
links, and other useful features and resources available in MHP.

DSN 312793
Elfe Merwitz - ellen L mery

DSN 312-956-6964, Fix §

Fill & Sign

Comment





image4.png




image5.png




image6.png




image7.png




image8.png




image9.png
Enwareh





image10.png




image11.png
Oline Trsining

[T —





image12.png




image13.png
= & Ammunition Forum

+ Safety
+ Logistics
+ Operations
9 Ask An Expert
+ Deployment Information
+ Knowledge Sharing/Forums
« Systems
« Publications
+ Training
« Ammunition Multimedia Encyclopedi
« Ammunition Media
+ HAZMAT Transportation
= CoP Newsletter
« Ammunition Material

4 What's New on the Ammo CoP




image14.png




image15.png




image16.png
DDESB





image17.png
(@ Explosives Safety Engineeri... %

ExplosivesSafety Engineering Division
(JMAC-ESE)
Updated - June 30, 2015

Explosives Safety Engineering Division Mission and Services

@ Mission/Functions

Search/View/Order Drawings
Online

Contact the Explosives Safety
Engineering Division
@ Customer Satisfaction Form

Projects

Mil-Handbook 138B

Special Projects





